
How to Export from Rhino to Revit: Step by step

Description

Rhino and Revit are two powerful software tools that cater to different aspects of the design process.
Rhino excels in its ability to create complex 3D geometries and supports free-form modeling, while 
Revit is known for its robust BIM capabilities and comprehensive project coordination features. When it
comes to transferring 3D models from Rhino to Revit, a well-executed export process is essential to
preserve design intent, ensure accuracy, and leverage the strengths of both platforms.

This comprehensive guide will walk you through the step-by-step process of exporting your models
from Rhino to Revit. We will cover important considerations, such as file formats, model preparation,
export options, import techniques, and post-import cleanup. By following these best practices, you can
achieve a seamless transition from Rhino to Revit, enabling effective collaboration, improved
coordination, and enhanced project outcomes.

Key Takeaways:

Understanding file formats and preparing the Rhino model are crucial steps before exporting to
Revit.
Export options include DWG, IFC, and SAT, with IFC being a preferred format for better
compatibility and preserving BIM data.
The export process involves selecting objects, adjusting settings, and generating the exported file.
Importing the exported file into Revit requires specifying units, coordinating systems, and
reviewing the imported model.
Post-import cleanup, fine-tuning the model, and leveraging plugins or add-ons can further
enhance the interoperability between Rhino and Revit.

Exporting from Rhino to Revit

1. Understanding File Formats
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Before delving into the export process, it’s important to be familiar with the file formats supported by
both Rhino and Revit. Rhino primarily uses the .3dm file format, while Revit relies on the .rvt and .rfa
file formats. To ensure a smooth transfer, we need to convert the Rhino model to a format compatible
with Revit.

2. Preparing the Rhino Model

To optimize the export process, it’s essential to prepare the Rhino model appropriately. Here are some
key steps to follow:

Clean the Model: Remove any unnecessary geometry, hidden elements, or overlapping
surfaces. This will simplify the model and prevent potential issues during the export.
Organize Layers: Assign appropriate layers to different elements of your model, such as walls,
floors, and furniture. This helps streamline the translation process and facilitates the
management of elements in Revit.
Check Unit Compatibility: Ensure that both Rhino and Revit are set to use the same unit
system. Consistent units are vital for accurate scaling and measurements in the exported model.
Validate Geometry: Confirm that the geometry of your model is valid and free from errors. Rhino
offers various tools, such as the “Check” command, to identify and fix any geometry issues.

3. Exporting Options

Rhino provides several export options to choose from. Let’s explore the most common ones for
exporting to Revit:

DWG/DXF: Rhino allows exporting to AutoCAD-compatible file formats, such as .dwg or .dxf.
While this method is widely supported by Revit, it may require additional steps for proper import
and conversion of the 3D geometry.
IFC: The Industry Foundation Classes (IFC) format is an open standard for BIM data exchange.
Exporting your Rhino model to IFC ensures better compatibility with Revit’s BIM environment and
preserves essential information such as geometry, materials, and object properties.
SAT: The .sat (ACIS) file format is another option for transferring 3D models between Rhino and
Revit. However, SAT files may require additional cleanup in Revit, as they often result in separate
3D elements rather than a cohesive building model.

4. Export Process

Once you’ve chosen the appropriate file format, follow these steps to export your Rhino model to Revit:

1. Select the desired objects or the entire model to be exported.
2. Go to the “File” menu and choose the “Export Selected” or “Export” option.
3. Specify the export format (e.g., DWG, IFC, or SAT) and provide a name for the exported file.
4. Adjust export settings as necessary, including unit scaling, layers, and object properties.
5. Click “Export” to generate the file.
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5. Importing into Revit

After exporting the model from Rhino, it’s time to import it into Revit. Follow these steps for a
successful import:

1. Open Revit and create a new project or open an existing one.
2. Go to the “Insert” tab and select the appropriate import option based on the file format you

exported from Rhino (e.g., Import CAD, Import IFC).
3. 3. Browse for the exported file and select it.
4. In the import settings, choose the appropriate units and coordinate system that match the Rhino

model.
5. Review the import options and make any necessary adjustments, such as mapping layers or

materials.
6. Click “Import” to initiate the import process.

6. Post-Import Cleanup

Once the Rhino model is imported into Revit, it’s important to perform a thorough cleanup to ensure the
model’s integrity. Consider the following tasks:

Merge Geometry: If the imported model consists of multiple individual elements, use Revit’s
tools to merge and join them into a cohesive building model.
Check and Fix Geometry: Review the imported geometry for any errors or inconsistencies.
Revit provides tools like “Check Model” and “Reveal Constraints” to identify and resolve issues.
Verify Object Properties: Check the properties of imported elements, such as walls, floors, and
components, to ensure they align with the intended design and specifications.
Update Families: Revit uses families for building components. Verify that the families used in the
Rhino model are compatible with Revit and update them if necessary.

7. Fine-Tuning the Model

After the initial import and cleanup, you may need to perform additional adjustments to enhance the
model’s accuracy and detail:

Rebuild Walls: Revit’s wall system may differ from Rhino’s, so consider rebuilding walls using
Revit’s native tools. This ensures proper alignment, connections, and parametric control.
Add Building Elements: Utilize Revit’s extensive library of components to add doors, windows,
furniture, and other architectural elements to enhance the level of detail in your model.
Assign Materials: Apply appropriate materials to different elements in the model to enhance the
visualization and rendering capabilities of Revit.
Coordinate with Other Disciplines: If you’re working in a collaborative environment, coordinate
with professionals from other disciplines (e.g., structural engineering, MEP) to integrate their
models into the Revit environment.
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Additional Tips and Resources

To further aid you in the process of exporting from Rhino to Revit, consider the following tips:

Stay Up-to-Date: Keep both Rhino and Revit software versions up-to-date to ensure
compatibility and access the latest features and enhancements.
Utilize Plugins: Explore plugins specifically designed to facilitate the transfer of models between
Rhino and Revit. Plugins like “RhinoInside” and “VisualARQ” can streamline the interoperability
process.
Online Communities and Forums: Engage with online communities and forums dedicated to
Rhino and Revit users. These platforms provide a wealth of knowledge, tips, and troubleshooting
assistance.
Training and Tutorials: Take advantage of online tutorials, video courses, and official
documentation to enhance your skills and deepen your understanding of the export process.

By following these steps and best practices, you can successfully export your designs from Rhino to
Revit, ensuring a seamless transition from 3D modeling to the comprehensive BIM capabilities of Revit.
Embrace the interoperability between these powerful tools to streamline your workflow, enhance
collaboration, and bring your architectural visions to life with precision and efficiency.

FAQ: Exporting from Rhino to Revit

1. How do I export from Rhino to Revit 3D?

To export a 3D model from Rhino to Revit, you can follow these steps:

1. In Rhino, select the objects or the entire model you want to export.
2. Go to the “File” menu and choose the “Export Selected” or “Export” option.
3. Select a compatible file format for Revit, such as DWG, IFC, or SAT.
4. Adjust the export settings, including unit scaling and object properties.
5. Click “Export” to generate the file.
6. Open Revit and import the exported file using the appropriate import function.

2. Can Revit open Rhino files?

Revit does not have native support for opening Rhino (.3dm) files. However, you can export your Rhino
model to a compatible file format, such as DWG or IFC, and then import that file into Revit.

3. Can Revit Open 3DM files?

No, Revit cannot directly open Rhino’s .3dm files. You will need to export your Rhino model to a
compatible format, such as DWG, IFC, or SAT, and then import that file into Revit.

4. How do you explode a Rhino file in Revit?
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In Revit, the concept of “exploding” a file is not directly applicable as it is in Rhino. Instead, Revit
focuses on working with parametric building elements. If you want to break down a complex imported
geometry into its individual components, you can use Revit’s modeling tools to edit and modify the
imported elements.

5. Does Rhino export to Revit?

Yes, Rhino can export models to formats that are compatible with Revit, such as DWG, IFC, or SAT.
By exporting from Rhino to one of these file formats, you can transfer your model to Revit for further
development and coordination within the BIM environment.

6. How do I import 3DM into Revit?

Since Revit does not natively support importing 3DM files, you will need to export your Rhino model to
a compatible format, such as DWG, IFC, or SAT. Once you have exported the model, you can use the
appropriate import function in Revit to bring the file into your project.

7. What is a 3DM file?

A 3DM file is a proprietary file format used by Rhino for saving 3D models. It contains geometry, layers,
materials, and other relevant data that constitute the design created in Rhino.

8. Is Rhino better than Revit?

Rhino and Revit serve different purposes in the design and construction industry. Rhino is primarily a
3D modeling tool with a focus on free-form design and complex geometry, while Revit is a Building
Information Modeling (BIM) software designed for architectural, structural, and MEP (mechanical,
electrical, plumbing) modeling and coordination. The choice between Rhino and Revit depends on your
specific needs and the project requirements.

9. What is Rhino inside Revit?

Rhino inside Revit is a technology that allows you to run Rhino and Grasshopper (a visual
programming language) inside the Revit environment. It provides a seamless integration between the
two software platforms, enabling users to leverage Rhino’s advanced modeling capabilities and
Grasshopper’s parametric design tools within Revit’s BIM environment. Rhino inside Revit enhances
interoperability and enables a more flexible and efficient workflow for design professionals.

10. What are the advantages of exporting to IFC format from Rhino to Revit?

Exporting from Rhino to the Industry Foundation Classes (IFC) format offers several advantages when
transferring models to Revit:

BIM Compatibility: IFC is an open standard for BIM data exchange, ensuring better compatibility
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between Rhino and Revit. By exporting to IFC, you can preserve important information such as
geometry, materials, and object properties, making it easier to work within Revit’s BIM
environment.
Data Integrity: IFC allows the transfer of complex data structures, including relationships
between elements, which are essential for accurate BIM representation. When exporting to IFC,
the data integrity of the model is maintained, ensuring consistency and reliability throughout the
design process.
Interoperability: IFC facilitates interoperability between different software platforms. By
exporting to IFC, you can exchange models with other professionals and disciplines seamlessly.
This promotes collaboration and coordination, especially in large-scale projects involving multiple
stakeholders.
Industry Standards: IFC is widely recognized and used within the AEC industry. By exporting
your Rhino model to IFC, you align with industry standards and increase the likelihood of
successful data exchange and collaboration with other professionals working with BIM tools.

11. Can I export Rhino materials to Revit?

While the direct transfer of Rhino materials to Revit is not supported due to differences in material
systems, you can still transfer material information by mapping Rhino materials to Revit materials
during the export/import process. This involves assigning compatible Revit materials to the
corresponding Rhino materials manually or using mapping strategies offered by specific plugins or
software solutions that enhance interoperability between Rhino and Revit.

12. How can I ensure accurate scaling when exporting from Rhino to Revit?

To ensure accurate scaling when exporting from Rhino to Revit, it’s essential to establish consistent
units between the two software platforms. Before exporting, verify that both Rhino and Revit are set to
use the same unit system (e.g., meters, millimeters, feet). This ensures that the model’s dimensions
and measurements are correctly interpreted during the export and import process, avoiding scaling
discrepancies in the transferred model.

13. Can I transfer parametric relationships from Rhino to Revit?

Transferring parametric relationships from Rhino to Revit can be challenging since the two software
platforms have different underlying philosophies. Rhino focuses more on free-form modeling, whereas
Revit emphasizes parametric design and object relationships. While it’s difficult to directly transfer
parametric relationships, you can recreate them in Revit using its parametric modeling tools after
importing the model. This allows you to take advantage of Revit’s capabilities for intelligent, data-driven
design.

14. Are there any limitations or considerations when exporting complex geometries from Rhino
to Revit?

When exporting complex geometries from Rhino to Revit, there are a few limitations and
considerations to keep in mind:
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Geometry Cleanup: Complex geometries in Rhino may need to be simplified or cleaned up
before exporting to Revit. Revit’s geometry engine may have difficulty processing highly detailed
or intricate forms, leading to performance issues or unexpected results.
Model Accuracy: While efforts are made to maintain accuracy during the export process,
complex geometries with intricate details or non-standard shapes may experience some level of
distortion or approximation when transferred to Revit. It’s important to review and validate the
imported model in Revit to ensure its accuracy matches the original intent.
Model Performance: Highly detailed or complex geometries can impact the performance of
Revit, especially during processes such as visualization, rendering, or model navigation. It’s
advisable to optimize the model in Revit by simplifying or grouping elements where possible to
maintain optimal performance.

15. How can I ensure a seamless workflow between Rhino and Revit?

To ensure a seamless workflow between Rhino and Revit, consider the following tips:

Standardize Naming Conventions: Establish consistent naming conventions for objects, layers,
and materials in both Rhino and Revit. This promotes clarity and simplifies the organization of
elements during the export and import processes.
Regularly Check for Updates: Keep both Rhino and Revit software up-to-date to benefit from
the latest features, bug fixes, and compatibility improvements. Staying current with software
updates helps ensure smoother data transfer between the two platforms.
Utilize Plugins and Add-ons: Explore plugins and add-ons designed to enhance interoperability
between Rhino and Revit. Plugins like “RhinoInside” or “Grasshopper for Revit” provide direct
integration and enable seamless data exchange and interoperability between the two software
platforms.
Collaborate Early and Often: Foster open communication and collaboration between team
members who use Rhino and Revit. Establish clear workflows and exchange requirements to
ensure a smooth transition of models, data, and design intent between the two platforms.
Test and Validate Transferred Models: After exporting a model from Rhino to Revit, thoroughly
review and validate the imported model in Revit. Check for any geometry or data discrepancies,
verify material assignments, and ensure that the model aligns with the intended design and
specifications.
Continued Coordination: Throughout the project lifecycle, maintain coordination between Rhino
and Revit users. Regularly update and transfer models between the platforms to reflect design
changes, ensure consistency, and facilitate collaboration among team members.
Training and Knowledge Sharing: Invest in training resources and encourage knowledge
sharing among team members. By enhancing skills and understanding of both Rhino and Revit,
professionals can navigate the export/import process more efficiently and address any potential
challenges.
Document the Workflow: Document the workflow for exporting from Rhino to Revit within your
organization. Create a step-by-step guide or internal documentation to ensure consistency and
facilitate knowledge transfer among team members.

By following these best practices, you can streamline the workflow between Rhino and Revit, enabling
a more efficient and collaborative design process while maximizing the strengths of each software
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platform.

Transferring 3D models from Rhino to Revit requires careful preparation, knowledge of file formats,
and attention to detail during the export and import processes. By following the steps outlined in this
guide, you can ensure an efficient and accurate transfer of your designs, leveraging the strengths of
both Rhino and Revit in your architectural projects.

Remember to prepare your Rhino model by cleaning up unnecessary geometry, organizing layers, and
validating the overall model. Choose the appropriate export format, such as DWG, IFC, or SAT, and
adjust the export settings accordingly. In Revit, import the exported file, ensuring the correct units and
coordinate systems are selected. Perform post-import cleanup, merging geometry, checking and fixing
any issues, and verifying object properties. Fine-tune the model by rebuilding walls, adding building
elements, assigning materials, and collaborating with other disciplines.

By mastering the export process from Rhino to Revit, you can unlock the full potential of both software
platforms, seamlessly transferring your designs and harnessing the power of BIM for efficient project
management, visualization, and collaboration in the architecture, engineering, and construction
industry.

CADDIKT
https://caddikt.com/

https://c
addikt.com/

Page 8
https://caddikt.com/


